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6 Finding Information

Finding Information

What are you looking for? Find it here:

How to set up my Dell DJ Ditty 
and information on the connectors 
and buttons on my Dell DJ Ditty.

Dell DJ Ditty™ Getting Started 
Guide and the Dell DJ Ditty™ 
Owner’s Manual

Information on using my Dell DJ 
Ditty.

Dell DJ Ditty™ Owner’s Manual

Information on using Musicmatch 
with my Dell DJ Ditty.

Musicmatch® online help

Click Start > All Programs> 
Musicmatch Jukebox. Click 
Help in Musicmatch.

Connecting to and synchronizing 
with a computer.

Dell DJ Ditty™ Owner’s Manual 
and Musicmatch online help
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Up-to-date information on your 
Dell DJ Ditty, including the latest 
software downloads, latest versions 
of the Dell DJ Ditty™ Owner’s 
Manual, Dell DJ Ditty™ Getting 
Started Guide, and answers to 
Frequently Asked Questions.

http://support.dell.com

Warranty information Dell DJ Ditty™ Product 
Information Guide

My Service Tag Located on the back of the Dell DJ 
Ditty

What are you looking for? Find it here:
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1
About Your Dell DJ Ditty

Introduction
Congratulations on purchasing the Dell DJ Ditty™! In this 
document, you can find instructions on how to use the key features 
of your new Dell DJ Ditty with the accompanying software. You can 
also find more sources of useful information in "Finding 
Information" on page 6.

Your Dell DJ Ditty comes with a Dell DJ Ditty™ Product Software 
CD that you can use to install software onto your computer. The 
software includes Musicmatch®, a soft copy of the Dell DJ Ditty 
Owner’s Manual and Acrobat Reader. You can use this software to 
manage your music library and to transfer audio tracks and data 
files between your Dell DJ Ditty and your computer. In order to 
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transfer these files, your Dell DJ Ditty must be connected directly 
to your computer's USB port. See "Installing Software" on page 12 
to get started.

After installing the software on your computer, you can use your 
Dell DJ Ditty in a number of ways:

• As a digital music player (see "Playing Digital Music" on 
page 19), or 

• As a data storage device (see "Transferring Music to the Dell 
DJ Ditty" on page 36), or

• As an FM Radio (see "FM Radio Using the Dell DJ Ditty" on 
page 26).

For details about using these features and getting the most out of 
your Dell DJ Ditty, see "Using Your Dell DJ Ditty" on page 19.

 NOTICE: Dell's Limited Warranty does not cover data loss resulting 
from the unlikely failure of the flash memory in the Dell DJ Ditty.

 NOTICE: While your Dell DJ Ditty is robust, do not subject it to 
excessive force or impact. This may damage your Dell DJ Ditty.
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Top, Front and Side Views

headphone connector

LCD screen

volume/scroll/select dial

USB connector

home/power button

fast forward /
 skip forward

 skip back
rewind /

play/pause

reset button

lanyard 
attachment

USB protective cap
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USB PROTECTIVE CAP - Keep attached at all times when your 
Dell DJ Ditty is not connected to a computer. This protects the 
USB connector.

USB CONNECTOR - Connects your Dell DJ Ditty to a computer 
to transfer data files or tracks, and charges the battery.

LCD SCREEN - Displays operating information.

HOME/POWER BUTTON - Main Menu/PowerOff/PowerOn 
Button.

HEADPHONE CONNECTOR - Connects earphones or 
headphones.

RESET BUTTON - Reset when your Dell DJ Ditty stops 
responding.

VOLUME/SCROLL/SELECT DIAL - Increases or decreases volume. 
Scroll to choose item from menu/list.

FAST FORWARD/SKIP FORWARD - Goes to next track or moves 
within a track.

PLAY/PAUSE - Starts or pauses a track.

REWIND/SKIP BACK - Moves to start of current track, or goes to 
previous track. Skips to move back within a track.
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LANYARD ATTACHMENT - Connects lanyard.

Installing Software
Your Dell DJ Ditty comes with software that helps you create audio 
tracks and manage Music Library.

To install software:

 NOTE: Ensure that your Dell DJ Ditty is not connected to your 
computer during the software installation process.

 NOTE: Close all other applications while installing the software.

1 Insert the Dell DJ Ditty™ Product Software CD into your CD 
drive. The CD runs automatically, and the installation process 
begins. If the CD does not run automatically:

a Using Windows® Explorer® or the My Computer icon, 
navigate to the drive where you loaded the Dell DJ 
Ditty™ Product Software CD.

b Double-click CDINSTALLER.EXE.
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2 When the Dell DJ Ditty installation screen appears, click OK 
to start the software installation process. Follow the 
instructions on the screen and click OK, Next, or Yes when 
prompted.

 NOTE: The software may determine that you have a different version 
of Musicmatch already on your computer. If so, you are asked 
whether or not you would like to continue installing Musicmatch from 
the CD. Make your selection to proceed.

• If you select Yes, the installation process continues. You 
must select Yes if you intend to use Musicmatch with 
your Dell DJ Ditty.

• If you select No, you are asked to confirm the selection. 
Select Yes to quit the installation.
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3 After the software installation is complete, a message appears 
asking if you want to restart your computer now or later. 
Select Yes to restart your computer immediately or No if you 
intend to restart your computer later.

 NOTE: The software is not enabled until after you restart 
your computer.

4 After restarting your computer, connect your Dell DJ Ditty to 
your computer. See "Connecting to your Computer & 
Charging the Battery" on page 14.

Connecting to your Computer & Charging 
the Battery
Connect your Dell DJ Ditty directly to the USB port of your 
computer in order to transfer data files or audio tracks, and to 
charge the battery.
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To charge the battery: 

Plug your Dell DJ Ditty directly into your computer’s USB port 
(see above). Leave the Dell DJ Ditty plugged in for 2.5 hours, in 
order to properly charge the battery.
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Your Dell DJ Ditty has an integrated, rechargeable, lithium-polymer 
battery. Before you use your Dell DJ Ditty for the first time, you 
must charge the battery for 2.5 hours. Use the battery icon on your 
Dell DJ Ditty’s screen to monitor the battery charge.

While the battery is being charged, the battery icon is animated. 
Once the battery is fully charged, the full battery icon  is 
shown.

During normal operation, the battery icon indicates approximate 
remaining battery power, as follows:

 4 bars - 79% to 100%

 3 bars - 58% to 78%

 2 bars - 36% to 57%

 1 bar - 16% to 35%

 0 bars - 0% to 15%

 NOTE: Do not use your Dell DJ Ditty for the first time until you have 
charged the battery for at least 2.5hours.

 NOTE: To charge your Dell DJ Ditty from your computer’s USB 
connector, your computer must be turned on.
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 NOTE: Charge your Dell DJ Ditty at least once a month, even if it is 
not being used.

 NOTICE: Do not attempt to replace or remove the integrated battery 
from your Dell DJ Ditty. You may damage the Dell DJ Ditty 
permanently. Any attempt to open your Dell DJ Ditty voids the 
warranty.

See "Transferring Music to the Dell DJ Ditty" on page 36 for 
information on transferring data files and audio tracks.

Performing a Reset
If your Dell DJ Ditty stops responding, perform a reset. 

To perform a reset:

1 Make sure the Dell DJ Ditty is disconnected from the 
computer.

2 Insert the end of a thin object, such as a straightened paper 
clip, into the reset button. 
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 NOTICE: Files or tracks that were being transferred may be lost but 
other data is normally retained.
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2
Using Your Dell DJ Ditty
Your Dell DJ Ditty can be used in different ways: 

• As a digital music player (see below), or 

• As a data storage device (see "Transferring Music to the Dell 
DJ Ditty" on page 36), or

• As an FM Radio (see "FM Radio Using the Dell DJ Ditty" on 
page 26).

Playing Digital Music
The Dell DJ Ditty can play tracks in MP3 or WMA file formats. It 
also has PlaysForSure support, meaning that you can play 
downloaded songs in WMA format with PlaysForSure Digital 
Rights Management technology. The Dell DJ Ditty comes with a 
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few sample MP3 tracks already loaded into the Music Library. 
To load your own music files onto the Dell DJ Ditty, see 
"Transferring Music to the Dell DJ Ditty" on page 36.

 NOTE: Scroll-select means to move the dial in the desired direction 
and press in on the scroll dial to select the item.

 NOTE: On the "Now Playing" screen, the buttons are defined as 
follows:

• Press the Play/Pause button  to pause or resume playing 
a track.

• Press the Fast Forward/Skip Forward button  to go to the 
next track.

• Press and hold the Fast Forward/Skip Forward button  to 
fast-forward within a track.

• Press the Rewind/Skip Back button  to go to the start of 
the current track, or the start of previous tracks. 

• Press and hold the Rewind/Skip Back button  to rewind 
within a track. 

• Scroll-right  to increase the volume.

• Scroll-left  to decrease the volume.
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• Press the Volume/Scroll/Select dial to switch between Title, 
Artist, or Album information (When listening to audiobooks, 
press the Volume/Scroll/Select dial to switch between Title, 
Artist, or Chapter information).

• Press and hold the Volume/Scroll/Select dial  to 
switch between lock  or unlock keys. 

How to Repeat a Marked Segment (AB mode)

 NOTE: You can only use AB mode with Music Tracks.

1 Press and hold the Play/Pause button  for 2 seconds and 
then release to activate the start point for AB mode ( ). 

2 With the start point for AB mode activated, while still on the 
same track, press and hold the Play/Pause button  for 2 
seconds and then release to activate the stop point for AB 
mode ( ). The chosen segment is repeatedly played 
until AB mode is cancelled.
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How to Cancel AB mode
With both the start and stop points for AB mode activated, press 
and hold the Play/Pause button  for 2 seconds and then release 
to cancel AB mode.

Managing Files from the Main Menu
The Main Menu of the Dell DJ Ditty is the starting place for the 
Dell DJ Ditty operations. 

To get to the Main Menu, press the Home/Power button on your 
Dell DJ Ditty. 

• Music Library is your window to the music tracks stored on 
your Dell DJ Ditty. 

• Play Mode enables you to change the sequence and manner 
in which tracks are played. 

• FM Radio enables you to manage your favorite FM radio 
stations. 

• Date & Time enables you to display the date and time 
settings and adjust your sleep timer. 
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• Settings & Info enables you to customize certain settings, 
such as EQ, to your personal preference, and provides you 
with data such as firmware version and space on your Dell DJ 
Ditty. 

Music Library 

Playing Music Tracks

Listed below are some quick tips on playing music on your Dell DJ 
Ditty.

To play music tracks:

1 Press the Home/Power button on your Dell DJ Ditty.

2 Scroll-select Music Library.

3 Scroll-select Music.

4 Press the Play/Pause button.

After pressing the Play/Pause button, your Dell DJ Ditty plays 
music tracks in the sequence determined by the Play Mode 
setting. 
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To change the Play Mode setting, see "Play Mode" on page 25.

Listening to Spoken Word Audiobooks

You can purchase and download spoken word audiobooks from 
http://www.audible.com and listen to them on your Dell DJ Ditty. 

You can use MusicMatch Jukebox to transfer audiobooks to your 
Dell DJ Ditty. 

If you stop listening to an audiobook on your Dell DJ Ditty and go 
back to it later, the audiobook begins playing from where you left 
off. 

 NOTE: All spoken word content is listed in the "Audiobooks" section 
of the Music Library.

To play audiobooks:

1 Press the Home/Power button on your Dell DJ Ditty.

2 Scroll-select Music Library.

3 Scroll-select Audiobooks.

4 Scroll-select the audiobook of your choice.

5 Press the Play/Pause button.
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To skip through sections in an Audiobook:

1 Press and hold the Play/Pause button  while in Audiobook 
mode until you see the  symbol on the screen.

2 Press Fast Forward or Rewind to skip to the next or previous 
section within a book.  

3 Press and hold the Play/Pause button to exit section skip 
mode.

Play Mode 
You can use the Play Mode function to determine the sequence of 
playing the selected tracks.

To view play mode options: 

1 Press the Home button on your Dell DJ Ditty. 

2 Scroll-select Play Mode. 

3 To change the play mode, scroll-select a play mode. 

Normal - Plays each track one time in sequential order. 

Repeat Track  - Repeatedly plays the selected track until you 
turn off the Dell DJ Ditty or change the play mode. 
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Repeat All  - Repeatedly plays all tracks until you turn off the 
Dell DJ Ditty or change the play mode.

Shuffle  - Randomly plays all tracks one time without 
repeating any tracks.

Shuffle Repeat  - Randomly plays all tracks, then repeats 
them in a different random sequence until you turn off the Dell DJ 
Ditty or change the play mode.

Play Mode icons are shown at the top of the display, as shown 
below. If no icon is present, this means that Normal Play Mode is 
activated.

FM Radio Using the Dell DJ Ditty
You can listen to and store your favorite FM radio stations on the 
Dell DJ Ditty.
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To listen to FM radio:

1 If your Dell DJ Ditty is not already turned on, press and hold 
the Home/Power button for 2 seconds.

2 Press the Home/Power button to access the main menu.

3 Scroll-select FM Radio.

4 If you see the message "AutoScan 10 stations to presets?", 
scroll-select Yes. This automatically searches for and saves the 
10 strongest-signalled stations as presets 1 to 10. During this 
process, "AutoScan" is displayed on the screen.

5 Once the scanning process has finished, "Preset 1" is displayed 
on the screen, and this station is played.

6 To listen to another station, press and release the 
Fast Forward or Rewind buttons to move to the 
next/previous preset.

 NOTE: You only need to Autoscan FM radio stations during initial FM 
Radio use. However, you can repeat this procedure at any time by 
pressing the scroll dial while in FM Radio mode and scroll-selecting 
AutoScan.

To tune to an FM radio station by frequency:
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1 Press the Home button.

2 Scroll-select FM Radio.

3 If you see the message "AutoScan 10 stations to presets?", 
scroll-select No.

4 Press the Play/Pause button. "SEEK" appears on the screen.

5 Press the Fast Forward/Skip Forward button to go to the next 
strong-signalled station. Press and hold the Fast Forward/Skip 
Forward button to advance by 0.1MHz. Similarly, you can use 
the Rewind/Skip Back button to search in the other direction.

To save an FM radio station as a preset:

Once you have tuned to a station using the above method, press 
and hold the Play/Pause button. Preset x (where x=1 to 10) blinks 
on the screen. Use the Fast forward/Skip Forward or Rewind/Skip 
Back buttons to increase or decrease the preset number, then press 
and hold Play/Pause to save.

To listen to a preset station:

1 Press the Home button.

2 Scroll-select FM Radio.
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3 Press the Play/Pause button until "Preset" is displayed on the 
screen.

4 Press the Fast Forward or Rewind button to go to the 
next/previous preset. Press and hold the Fast Forward or 
Rewind button for 2 seconds to go to the next/previous preset, 
play that station for 5 seconds and then move to the 
next/previous one, giving you a preview of all stations. To 
cancel, press the Fast Forward, Rewind or Play/Pause button.

 NOTE: Use the Volume/Scroll/Select dial to adjust the volume of an 
FM radio station.

 NOTE: Press the Volume/Scroll/Select dial to enter the FM Radio 
Menu. Scroll-select AutoScan to go through the autoscanning 
procedure. 

Date & Time
Enables you to display and set the date and time and adjust the 
sleep timer.

You can select: 
• Display - view date and time, as well as sleep time 
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• Sleep timer - choose how much time passes before your Dell 
DJ Ditty shuts itself off. 

• Set Time - change the time

• Set Date - change the date

To view the time, date and day: 

1 Press the Home button. 

2 Scroll-select Date & Time. 

3 Scroll-select Display. The date and time appear.

To set the sleep timer: 
1 Press the Home button. 

2 Scroll-select Date & Time. 

3 Scroll-select Sleep Timer. A list of available times appears. 

4 Scroll-select a duration. 

 NOTE: The Idle Timer is different from the Sleep Timer. 

To set the time:

1 Press the Home button. 

2 Scroll-select Date & Time. 
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3 Scroll-select Set Time. 

4 Scroll-select Change.

5 Scroll-right to increase, or left to decrease the item which is 
highlighed.

6 Press the Volume/Scroll/Select dial to change which item is 
highlighted (e.g. to change the highlighted item from hours to 
minutes).

7 Scroll-select < to accept the new time.

To set the date:

1 Press the Home button. 

2 Scroll-select Date & Time. 

3 Scroll-select Set Date. 

4 Scroll-select Change.

5 Scroll-right to increase, or left to decrease the item which is 
highlighed.

6 Press the Volume/Scroll/Select dial to change which item is 
highlighted (e.g. to change the highlighted item from month 
to day).
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7 Scroll-select < to accept the new date.

Settings & Info

Settings

You can customize the Dell DJ Ditty to your preferences by 
adjusting the settings.

You can set:

• EQ - choose from available EQ presets

• Backlight - choose how long the backlight remains lit

• Contrast - choose a contrast level for optimal viewing

• Idle Timer - choose how much idle time passes before your 
Dell DJ Ditty shuts itself off 

• Language - choose the Dell DJ Ditty’s menu language

To select an EQ setting:
1 Press the Home button.

2 Scroll-select Settings & Info.

3 Scroll-select Settings.
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4 Scroll-select EQ. A list of EQ presets appear. To select one of 
the EQ presets, scroll-select the preset. 

To set the backlight duration:
1 Press the Home button.

2 Scroll-select Settings & Info.

3 Scroll-select Settings.

4 Scroll-select Backlight. A list of available durations appears.

5 Scroll-select a duration

To set the contrast level:

1 Press the Home button.

2 Scroll-select Settings & Info.

3 Scroll-select Settings.

4 Scroll-select Contrast. A level-bar of contrast levels appears.

5 Scroll-select a level.

To set the idle timer:

1 Press the Home button.
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2 Scroll-select Settings & Info.

3 Scroll-select Settings. 

4 Scroll-select Idle Timer. A list of available times appears.

5 Scroll-select a shutdown time.

 NOTE: Your player is "idle" when you do not press a player button and 
you do not have any tracks playing during the specified duration.
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To set the menu language:

1 Press the Home button.

2 Scroll-select Settings & Info.

3 Scroll-select Settings.

4 Scroll-select Language. A list of available languages appears.

5 Scroll-select a language.

Information

Provides you with information such as:

• Firmware version

• Total amount of space for storing music or data

• Available space for storing music or data

• Number of tracks stored

To check the information for your Dell DJ Ditty:

1 Press the Home button.

2 Scroll-select Settings & Info.

3 Scroll-select Information
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Transferring Music to the Dell DJ Ditty
With Musicmatch®, you can transfer music tracks from your 
personal music library to the Dell DJ Ditty. Musicmatch has the 
capability to ‘rip’ or convert music CDs to digital music files on 
your computer. Refer to the Musicmatch Help tutorial to create 
digital music files from your music CDs. 

 NOTE: Before transferring data files or music tracks, you must first 
connect your Dell DJ Ditty to your computer.

Transferring Music Tracks Using Musicmatch®

to Your Dell DJ Ditty 
Dell DJ Ditty software powered by Musicmatch® makes buying and 
enjoying digital music easy by providing a simple graphical 
interface between your computer and the Dell DJ Ditty, as well as 
access to the Musicmatch Downloads service. Some of the basic 
features of Musicmatch are covered below, but for complete 
instructions on how to use the Musicmatch software, click Start > 
All Programs > Musicmatch Jukebox. Click Help in Musicmatch 
(see "Finding Information" on page 6). 
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Transferring Music Tracks from Musicmatch Library

1 Connect the Dell DJ Ditty to your computer. 
2 Start Musicmatch by clicking Start > All Programs > 

Musicmatch Jukebox. The Musicmatch main window appears.
3 Click View > Portable Device Manager.
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Using Drag-and-Drop:

1 Follow steps 1 through 3 on page 38.

2 With the Portable Device Manager (PDM) open, you can 
transfer tracks in a drag-and-drop operation from your 
computer's Musicmatch Jukebox onto the Dell DJ Ditty.

3 To drag-and-drop, locate and click the track that you want to 
copy, then drag it to Dell DJ Ditty.

Using the Add Tracks button:

1 Open the Portable Device Manager (PDM) as described above.

2 Click the Add Tracks button.

3 Click the Library, Playlists, My Music, Desktop, or 
My Computer icon on the left side of the "Add tracks to 
Dell DJ Ditty" window.

4 To add all categories, click Select All and then click OK. 
To add one category, select the category and click OK. 
Double-click a category to see its sub-categories and tracks. 
Musicmatch displays the main PDM window when all 
selected tracks are added.
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Using Synchronization:

1 Open the Portable Device Manager (PDM) as described above.

2 Click the Sync button to update your Dell DJ Ditty with 
tracks from your computer.

 NOTE: The first time you use the Sync feature, it may be necessary 
to set your preferences in the Portable Device Assistant, if you have 
not already done so. If this is the case, the Portable Device Assistant 
appears automatically.

 NOTE: Synchronization is a one-way process that copies files from 
the computer to the Dell DJ Ditty. Select Help on the Musicmatch 
toolbar for more information.

Storing Data Files on the Dell DJ Ditty
You can store data files on your Dell DJ Ditty in the same way as a 
standard USB Flash Memory device.

To transfer files:

1 Using Windows® Explorer® or the My Computer icon, 
navigate to the My Computer folder.

2 Your Dell DJ Ditty is displayed as an MTP Player (See below).
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3 Within the MTP directory, there are two folders: Data and 
Media. Be sure to copy-and-paste/drag-and-drop any data files 
into the Data folder.
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3
Frequently Asked Questions
This section covers common problems you might encounter or 
questions you might have while using your Dell DJ Ditty. If you 
have a problem that is not addressed in this chapter, visit 
http://support.dell.com for more information.

Installation
1 I can’t install the Dell DJ Ditty software on my computer, 

which has Microsoft® Windows® 95, Windows 98 or 
Windows 2000 installed on it. The installation stops halfway.

You cannot install the Dell DJ Ditty software on a computer 
with Windows 95, Windows 98 or Windows 2000.
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Upgrade your computer’s operating system to Windows XP 
(with Windows Media Player 10.0 or above) before 
attempting to install the Dell DJ Ditty.

2 My Dell DJ Ditty is not recognized by Musicmatch, after 
installing the software from the Dell DJ Ditty™ Product 
Software CD.
In Musicmatch I can’t see my Dell DJ Ditty.

Your Dell DJ Ditty was probably connected to your computer 
during the installation. 

Your Dell DJ Ditty may not be properly connected to your 
computer.

Disconnect your Dell DJ Ditty and restart your computer. You 
may also have to re-install the software from the Dell DJ 
Ditty™ Product Software CD. Be sure to follow the 
installation steps carefully. Do not connect your Dell DJ Ditty 
to your computer during software installation.

You may not have the latest version of Windows Media Player 
installed on your computer. Previous versions might cause your 
Dell DJ Ditty not to be recognized.
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Download and install the latest version of Windows Media 
Player.

Usage
1 I can’t turn my Dell DJ Ditty off.

I was using my Dell DJ Ditty, and now the Dell DJ Ditty is 
not responding.

The keys on the Dell DJ Ditty have been locked.

Unlock the keys by pressing and holding the 
Volume/Scroll/Select dial until the lock icon  disappears.

The Dell DJ Ditty’s operating system may be locked.

Insert the end of a thin object, such as a straightened paper 
clip, into the reset button, located next to the headphone 
connector on your Dell DJ Ditty.

2 I’ve disconnected my Dell DJ Ditty from my computer, but 
the display still shows that it is connected.

The Dell DJ Ditty’s operating system may be locked.
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Insert the end of a thin object, such as a straightened paper 
clip, into the reset button, located next to the headphone 
connector on your Dell DJ Ditty.

3 My computer does not recognize my Dell DJ Ditty.

You may be using a USB hub to connect your Dell DJ Ditty to 
your computer.

Connect your Dell DJ Ditty directly to your computer’s USB 
port.

Your computer’s USB port may not be functioning properly.

Connect your Dell DJ Ditty to another USB port which is 
known to function correctly.

General
1 When I listen to music tracks, I hear a lot of noise or drop-

outs.

The track you are listening to was not recorded or encoded 
properly.
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Verify that the music track sounds the same when you play it 
from the Dell DJ Ditty and from your computer. You can then 
acquire a better recording of the track and transfer it to your 
Dell DJ Ditty.

Firmware Upgrade
 NOTICE: This step replaces the operating software (firmware) on 

your Dell DJ Ditty with a newer version.

Make sure a suitable firmware file is copied to your computer 
before performing this operation.

The latest firmware file can be downloaded from 
http://support.dell.com.

To upgrade the firmware:

a Connect your Dell DJ Ditty directly to and available USB 
port on your computer.

b Run the firmware update program and click the "Next" 
button.

c Verify that the "Format Data Area" option is unchecked, 
then click the "Start" button.
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 NOTICE: All files and music tracks are lost if "Format Data Area" is 
checked.

d After firmware upgrade is complete, disconnect your Dell 
DJ Ditty from the computer.

e The Dell DJ Ditty restarts.

 NOTE: Restarting the Dell DJ Ditty may take up to 2 minutes.

Warning Indications
1 Low Battery Shutting Down

The battery is low or depleted.  Connect the Dell DJ Ditty to 
a powered USB port and allow the unit’s battery to charge 
fully.

2 License Expired

The Subscription Song license has expired. Connect the Dell 
DJ Ditty to the PC and perform a music track sync to refresh 
all licenses automatically.

3 Error! Reformat with Firmware Updater
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Flash memory data error. Follow the steps Reload or Upgrade 
firmware with “Format Data Area” checked in the 
Troubleshooting section.

Troubleshooting
1 All the buttons on my Dell DJ Ditty are not responding and 

there is a lock icon  on the LCD Screen

The Button Lock function has been activated.  Press and hold 
the Volume/Scroll/Select dial until the lock icon disappears, 
and then release the button.

2 LCD Display is frozen

The Dell DJ Ditty is unresponsive to all button presses and 
the Button Lock function has not been activated. Make sure 
your Dell DJ Ditty is not connected to your computer and 
perform the reset. To perform the reset, insert the end of the 
thin object, such as a straightened pin paper clip, into the 
reset button near the headphone jack. See "Performing a 
Reset" on page 17 for more information.

3 Your Dell DJ Ditty is Frequently Unresponsive
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i. Reset Dell DJ Ditty

Make sure your Dell DJ Ditty is not connected to your 
computer. To perform the reset, insert the end of the thin 
object, such as a straightened pin paper clip, into the reset 
button near the headphone jack.

ii. Format Dell DJ Ditty

 NOTICE: Be sure to backup all the files and music tracks in your Dell 
DJ Ditty before performing this step.

 NOTICE: All files and music tracks in your Dell DJ Ditty are lost when 
this operation is selected.

Ther are two ways to format data on your Dell DJ Ditty.

Format using Musicmatch Jukebox:

a Run Musicmatch® Jukebox.

b Connect your Dell DJ Ditty to your computer.

c Click the “Portable Device” button on the left-hand side 
of the screen.

d The “Portable Device Manager” window pops up.
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e Click the “Tools” button on the right-hand side of 
“Portable Device Manager” window.

f Choose the “Format media”.

g Disconnect your Dell DJ Ditty and reboot it

Format using Windows Media Player 10:

a Run Microsoft® Media Player 10.

b Connect your Dell DJ Ditty to the computer.

c Click the Sync feature.

d Click the “Format storage media” button on the right-
hand side of the screen.

e Disconnect your Dell DJ Ditty and reboot it.

iii. Reload or Upgrade firmware with “Format Data Area” 
checked.

 NOTICE: This step replaces the operating software (firmware) in your 
Dell DJ Ditty with a newer version.

You should always have the latest firmware installed in your 
player.
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For steps to check the firmware version, refer to "Provides you 
with information such as:" on page 35.

The latest firmware file can be downloaded from 
http://support.dell.com.

Make sure a suitable firmware file is copied to your computer 
before performing this operation.

a Connect your Dell DJ Ditty to your computer.

b Run the firmware update program and click the Next 
button.

 NOTICE: Be sure to backup all the files and music tracks on your Dell 
DJ Ditty before performing this step.

c Check the "Format Data Area" option and click the Start 
button.

 NOTICE: All files and music tracks on your Dell DJ Ditty are lost if 
"Format Data Area" is checked.

d After the firmware upgrade is complete, disconnect your 
Dell DJ Ditty from the computer.

e The Dell DJ Ditty will restart.
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 Restarting the Dell DJ Ditty may take up to 2 minutes.

Musicmatch

Musicmatch Jukebox FAQ
1 Are there other services available to use with Musicmatch 

Jukebox? 

Musicmatch Jukebox comes fully integrated with 
Musicmatch Radio, Musicmatch Music Store and 
Musicmatch On Demand. These services help you listen to 
and discover music in ways never before possible, or as easy, on 
your personal computer. For more information click the On 
Demand, Music Store or Radio buttons on the Musicmatch 
Jukebox interface. 

2 If I install Musicmatch Jukebox over a previous version, does 
it delete my playlists or libraries? 

Musicmatch Jukebox preserves both your Playlists and Music 
Library content if you install using the default installation 
options. If you opt to change your default installation to a 
custom install in a different location, you may have to re-add 
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your music files to your Music Library and rebuild your 
Playlists. Your music files still remain on your computer and 
do have not been removed. 

3 I'm getting an error when trying to update the firmware on 
my Dell DJ Ditty

If you are getting the error: 

"PC Firmware update cannot proceed because Musicmatch 
Jukebox software is interfering, please restart system and run 
this firmware update again."

Try opening the task manager and ending the "mim" process.

a Press Ctrl+Alt+Delete on your keyboard.

b From Windows Task Manager, select the Processes tab.

c Highlight mim.exe and select the End Process button

d Select Yes to the Task Manager warning

e Proceed with the firmware update

f If problem remains, restart the system and update the 
firmware again.
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4 The tracks in my Library have different colored icons next to 
each track. What does each color mean? 

• Gray music-note icons represent standard MP3, 
mp3PRO, WMA and WAV music files. 

• Green music-note icons represent purchased Musicmatch 
Downloads tracks.

• Orange sound waves are links to Internet streamed files 
playable through your Music Library.

• Blue sound waves are Musicmatch On Demand tracks 
playable through your Music Library.

• A CD represents a CD that is inserted into your CD 
drive, and it represents albums when in View By Album 
mode.

• A white page represents a playlist. 

Musicmatch On Demand
1 What is Musicmatch On Demand?

Musicmatch On Demand gives you instant access to over 
1,000,000 tracks, letting you decide the exact artist and the 
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exact tracks to play. Create Playlists of different tracks, 
discover new music by Genre, Era, Artist, Album or Track, 
save tracks to your Music Library, and access your 
Musicmatch On Demand account from any PC in the world. 
Subscribing to Musicmatch On Demand also gives you access 
to premier Musicmatch Radio service. 

2 What is Musicmatch On Demand Portable?

Musicmatch On Demand portable, "all you can eat" music 
service, enables you to transfer to your portable device all the 
music your portable device can hold, for a monthly 
subscription. Over 1,000,000 tracks are available to download 
on up to 3PCs, and up to 3 portable devices per PC. Fill and 
refill your portable device as often as you’d like, and your 
subscription includes all the benefits of Musicmatch 
Premium Radio and On Demand services. You may also save 
On Demand portable tracks to your Music Library for 
listening while off line. 

Your computer should be running Windows XP, Windows 
Media Player 10.0 or above, and have Musicmatch Jukebox 
10.1 or above installed. You’ll also need a compatible portable 
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device such as the Dell DJ Ditty. Players need to be 
PlaysForSure compatible.

3 How do I download tracks to my Dell DJ Ditty?

a Launch Musicmatch Jukebox and sign in to your account. 

b Search for the artist(s) that you’d like to download to 
your Dell DJ Ditty by typing their name into the Search 
field and clicking Go.

c Once you’ve found the artist, click an album in the 
Album view where you’ll have the option to download an 
album or single track to your Dell DJ Ditty.

d By clicking the Send to Portable button next to the 
album or single track, the transfer begins. First the 
Portable Device Manager launches and tracks transfer to 
your PC, and then to your Dell DJ Ditty. Once tracks 
have transferred you get the message, "Done!"

4 How do I purchase Musicmatch On Demand tracks?

While listening to On Demand tracks, right-click on the track 
in the Playlist Window and select Buy Track. The Music Store 
appears and displays tracks available for purchase from that 
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artist. Click the Buy Track or Buy Album button to purchase 
and download tracks.

5 How do I save Musicmatch On Demand tracks to my Music 
Library?

"On Demand" subscribers may save a single track or an entire 
album from Musicmatch On Demand to the Music Library. 
While listening to an artist, click the Save to Library button 
next to the album, or Save button next to each track, and it is 
saved directly to your Music Library in Musicmatch Jukebox. 
It can then be played like any normal digital file. You must be 
logged into your account to play tracks from your Library.

"On Demand portable" subscribers may also save tracks to the 
Music Library, and enjoy them later without even being 
connected to the Internet. 

6 How Musicmatch On Demand tracks look different from 
regular tracks in your Music Library

Musicmatch On Demand tracks are designated by a grey 
"soundwave" icon next to the track, and the file in the Music 
Library reads "Musicmatch On Demand". Regular tracks are 
designated with a musical note.
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7 How to view Musicmatch On Demand tracks only in your 
Music Library

To view only your Musicmatch On Demand tracks in your 
Music Library, do the following:

a Open Musicmatch Jukebox.

b Click the Options from the menu bar.

c Select Music Library.

d Select View.

e Select View On Demand Tracks to see only your saved 
On Demand tracks.

8 How to control Musicmatch On Demand tracks

The Musicmatch On Demand service lets you play, pause, 
rewind and fast-forward through each track. You may play any 
track you would like, as many times as you would like, or 
simply let Musicmatch On Demand play a complete Playlist 
of related artists or albums for you non-stop. 

9 How to share Musicmatch On Demand tracks
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While listening to a Musicmatch On Demand Playlist, click 
the Send To button, and then select A Friend (email track 
list). Enter your name, the Playlist name, an optional message 
and the email addresses of those you would like to receive 
your Playlist. Then click Send Playlist. Recipients are able to 
enjoy your Playlist after downloading and installing the latest 
version of Musicmatch Jukebox. See the Terms of Use at 
http://www.musicmatch.com for important limitations. 

10 How to personalize Musicmatch On Demand to match your 
taste in music

• You can create a customized listening experience based 
on the exact types of artists, music or eras you enjoy most. 
While in Musicmatch On Demand, click the Tools 
button, and then select Personalize. 

• You may type in the names of up to 10 artists in the list 
provided, and find related music by clicking the Related 
button next to each entry. Related artists are listed based 
on the options above your list, including Related artists, 
Popularity, Era or Genre. 

• Click the Add button to add related artists to your list. 
Click Save and Close once done. 
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• Clicking My Matches presents you with similar music, 
that you can relate to and enjoy. 

11 Can I burn CDs from Musicmatch On Demand tracks?

Musicmatch On Demand tracks cannot be burned to CD. 
However, purchased tracks can be burned to CD and sent to 
your portable player. Simply right-click on a Musicmatch On 
Demand track and select Buy Track.

12 What are license agreements and why do they expire in 
Musicmatch 10.1?

When you purchase music, you purchase the rights to listen 
to that music, you do not actually own the music. The License 
Agreement enforces this rule, making it possible for you to use 
the Musicmatch service. Because of music industry 
guidelines, you must now renew the music license every 30 
days. To do this, simply plug your device into your computer, 
launch Musicmatch Jukebox, and sign in to your account. 
Once you sign in, your licenses renews automatically and you 
are able to continue listening to your On Demand portable 
tracks. As long as you sign in to your account at least every 30 
days, the license renews for you automatically. 
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Musicmatch Radio
1 Do I need an account to use Musicmatch Radio?

You may listen to any of our professionally, pre-programmed 
stations such as Era stations, or Most Popular Stations, with 
over 1,000,000 tracks available, without creating a 
Musicmatch Jukebox account. If you opt to listen to these 
free stations, you have access to CD-quality streaming and 
Artist Match radio for one hour. Upgrading to Premium Radio 
gives you unlimited CD-quality listening, customizable 
stations and Artist Radio, playing only the artists you want to 
hear, when you want to hear them. To upgrade, click the 
Upgrade to Premium Radio button below the Playlist 
Window.

2 There are a few artists that I really like. Can I listen to only 
those artists’ tracks? 

Artist Radio plays music from the artists you choose, and plays 
track after track from that artist exclusively. You can hear an 
entire collection from one, or multiple artists with no 
interruptions and in CD-quality sound. Artist Radio is 
available through Premium Radio. To upgrade, click the 
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Upgrade to Premium Radio button below the Playlist 
Window in Musicmatch Jukebox. 

3 I love the 70s, can I listen to music only from that era? 

Era stations transport you to the decade, or specific year, from 
which you enjoy music most. Select Eras from the Radio 
home page and you can quickly find the year you would like, 
and specific artists from that year. 

4 Can I create a list of artists I’d like to listen to in the future 
without buying anything? 

To create a list of artists to listen to in the future without 
purchasing any tracks, simply right-click on the artist’s name 
in the Radio window and select Add to Favorites. The track 
and artist information is stored in your personal Favorites list 
that you can view and edit anytime by clicking the Favorites 
link in the Radio window. 

5 I’d like a station that reflects my personal taste in music. 
Can I create such a station? 

To create a customized station of tracks that reflect your 
personal taste, do the following:
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a Open Musicmatch Jukebox.

b Click View from the menu bar.

c Select Musicmatch Radio.

d Select a pre-programmed Radio station that most directly 
matches your ideal station and play it by clicking on that 
station’s Play button.

e Click the Tools button.

f Select Create/Edit Custom Station. From here you are 
able to customize the perfect, personalized station with 
the artists you choose. Play your custom station in the 
future by clicking the Favorites button. 

6 Can I skip songs if I don’t like the song I'm listening to? 

Be sure you are logged in to your Musicmatch Radio Platinum 
account and that you are listening to Artist On Demand. The 
unlimited skipping feature is available in Artist On Demand 
mode only. If you are listening in Artist MATCH mode, you 
are not able to use unlimited skipping. 

7 Am I limited to the amount of artists I can listen to on 
Musicmatch Radio? 
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There is no limit to the amount of artists available for your 
listening pleasure in Musicmatch Radio. You have full access 
to over 1,000,000 tracks from thousands of artists. You can 
listen to music you have not heard in years, and hear songs for 
the first time exclusively on Musicmatch Radio. From the 
Radio home page, select Stations, Eras, Most Popular 
Stations, Top Artists, or search for your favorite artists, album 
or track by typing it into the Search field and clicking the Go 
button. 

Musicmatch Music Store
1 What is the Music Store?

Musicmatch Music Store is where you can purchase hundreds 
of thousands of tracks from the biggest artists in music today. 
Searching for your music using our powerful search tools is 
simple and fast, helping you to find music by artist, album, 
track, era or by an artist’s popularity. Purchasing happens in as 
fast as two clicks. Open your free account today by clicking on 
the Account button within Musicmatch Jukebox. 

2 Are the files I’m downloading high quality? 
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The tracks available from Musicmatch are encoded using a 
Variable Bitrate in high-end CD quality sound. Variable 
Bitrate encoding is an encoding method that ensures 
consistently high audio quality throughout an encoded file by 
making decisions on recording quality based on audio 
complexity. The average bitrate for these tracks is 
approximately 160kbps. 

3 How many tracks can I download?

There is no limit to how many tracks you can download. The 
most important factor is the amount of space on your hard 
drive. On average, each track takes about 5MB of disk space.

4 Can I make CDs from my Musicmatch Downloads tracks? 

To download a track from Musicmatch Music Store and burn 
it to CD, do the following:

a Locate the track you wish to purchase.

b Click the Buy Track button.

c Click the Confirm button to confirm your purchase.

The track downloads and is then added to the Playlist window. 
To burn this track to a CD, do the following:
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a Insert a blank CD-R disc.

b Click the Burn button in the Playlist window.

c Once Musicmatch Burner opens, select the type of CD 
you wish to create (Musicmatch Burner defaults to Audio 
CD).

d Click Burn to start the burn.

 NOTE: You must have an Internet connection to burn tracks 
downloaded from the Musicmatch Music Store to CD, as a burn 
license must be obtained prior to burning. Additionally, tracks 
can be burned to CDs, but the same Playlist may only be burned 
up to five (5) times. 

5 Can I copy Musicmatch Download tracks to my portable 
device? 

You can copy your downloaded tracks to your portable device 
by creating a Playlist of the tracks you would like to send to 
your portable device. 

a Click the Send To button below the Playlist window, and 
then select Portable Device. 
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b Attach your device according to the Getting Started 
Guide. Your tracks are copied over to your device. 

6 I have multiple computers in my home. May I listen to my 
Musicmatch Downloads tracks on all of them?

Musicmatch Downloads can be played on up to five 
computers. Once you have purchased and downloaded a 
Musicmatch Downloads track, you can move it to four 
additional computers using the following steps:

a Copy the tracks to the new machine. You can do this by 
burning the tracks to a CD using Musicmatch Burner. Or, 
if you are in a network workgroup, you can copy the tracks 
to the additional computers via your local area network.

b Once you have transferred the tracks to the additional 
computers, first log in to your Downloads account before 
adding them to the Musicmatch Playlist or Musicmatch 
Burner. 

 NOTE: If you are also subscribed to Musicmatch MX and use 
the "Remember Me" feature on this computer, for security 
reasons you need to log out and log back in before adding 
tracks to the computer.
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7 To log in to your Musicmatch Downloads account:

a Open Musicmatch Jukebox.

b Click the Login button (top left of the track downloads 
window.) 

 NOTE: If you see your login name, click it to log out and log 
back in.

c Enter your username and password in the fields provided.

d Click on the Login button.

Now that you are logged into your Musicmatch Downloads 
account, you are ready to play and burn your Musicmatch 
Downloads tracks from this computer. Using any of the 
available options (Music Library, Windows Explorer, Playlist 
buttons, etc.), add your tracks to the Musicmatch Playlist or 
Musicmatch Burner.

If this is the first time playing or burning Musicmatch 
Downloads tracks you've purchased with your account on this 
computer, a window pops up to ask if you would like to 
activate this computer. Click Yes to activate. This message 
also indicates how many computers you have activated. If you 
already have five computers activated for Musicmatch 
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Downloads, you are not able to activate a new computer. You 
must first deactivate one of the five activated computers 
using the Manage Active PCs button in Account 
Management.

Deactivation of a computer is permanent and can only be 
performed on the computer that you wish to deactivate. If you 
no longer have access to a computer you wish to deactivate, 
contact Musicmatch Customer Support for assistance. 

8 What happens if I lose my Internet connection while 
downloading tracks? 

If you have lost your Internet connection during a track or 
album download, do the following:

a Logout of your Musicmatch Download account.

b Close Musicmatch Jukebox.

c Open Musicmatch Jukebox.

d Log into your Musicmatch Downloads account.

e Click on the Download Status link in the Music Center.

Any tracks that are pending should attempt to download 
again.
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Musicmatch Music Store Troubleshooting
1 I get an error when logging in, "A newer version of Microsoft 

DRM is required to support Musicmatch On Demand..."

The Digital Rights Management file system has somehow 
been changed to an older version and must now be corrected. 
You'll need to download the latest version of Musicmatch 
Jukebox from the Musicmatch website, and then reinstall it 
on your system. This should correct the error. 

2 When trying to download a track to my Dell DJ Ditty, an 
error message tells me I must upgrade to On Demand

Tracks from older versions of the On Demand service are not 
portable. If you converted your Musicmatch account to a 
Yahoo! account, you’re not automatically updated to the On 
Demand portable service.

We now have two On Demand subscriptions levels [currently 
both are offered at the same price]. It is recommended that 
you upgrade your subscription to On Demand Portable. You 
can do this by logging into your Jukebox account, pressing the 
Account button, and selecting Edit Subscription. 
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3 When trying to play an On Demand track from the Library 
or On Demand tab the Player freezes

There may be a corrupted license file. To check and update 
this file:

a Check to see what version of wmvcore.dll you are using. It 
is located in C:\Windows\System 32\wmvcore.dll. Right-
click on dll and select properties. Then select the 
Properties tab. You should be on version 10.10.3802.

b If not, update to windows media player 10. If you already 
have it, check for updates. (In Windows Media Player 10, 
go to Help > Check for Player Updates. This needs to be 
done twice for an update to start. This is a minor 
Microsoft bug, however if an update is available it should 
start on the second try).

4 I updated to 10.1 and converted my account, but I still can't 
transfer to my device. I get a message telling me to upgrade 
my subscription. 

We now have two On Demand subscriptions levels. If you like 
to transfer tracks to your portable device, upgrade your 
subscription to On Demand Portable. You can do this by 
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logging into your Jukebox account, pressing the Account 
button, and selecting Edit Subscription.

5 I can no longer play my On Demand Portable tracks

Musicmatch On Demand Portable tracks must be renewed 
every 30 days or the license expires. Renewing the license is a 
simple process that takes about a minute.

Be sure your Internet connection is active, and then launch 
Musicmatch Jukebox, click the Sign in button, and sign in to 
your account. The track licenses should automatically refresh 
and be usable for another 30 days.

If the track licenses do not renew (you still can’t play back 
after signing in), it could be that your On Demand Portable 
subscription has expired. Update your subscription by signing 
in to your account, and then click the Edit Subscription 
button. Once updated, your track licenses should renew.

If the track still does not play, you may need to delete the 
track from the computer file system (not just the Musicmatch 
Library), and then re-download the file from the On Demand 
window.
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6 What is firmware and why do I need to update my portable 
device with a newer version? 

Firmware is what drives your hardware to perform tasks such 
as play music, show tags, add and remove music from your 
device, etc. Firmware talks to the operating system to 
accomplish other tasks as well, such as managing digital rights 
for music. Janus, the new DRM solution from Microsoft, 
requires that your portable device have its firmware updated 
so that it can speak the language of the Janus system, and 
provide you with safe, legal music.

Check the Musicmatch website to see if your device is 
compatible.

If you need to update your firmware, follow the 
manufacturer’s instructions for obtaining, and installing 
firmware for your device.

7 I get an error message when I attempt to sign in to my On 
Demand account

If you receive an error message while trying to sign in, or use 
your On Demand Portable account, there are several solutions 
that could help you to resolve the problem.
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Error Messages
"Unsupported Operation: You must be logged-in to your On 
Demand portable account to download and transfer On Demand 
tracks to your portable device."

"On Demand services are currently unavailable. Updating your PC 
settings may resolve the problem. Go to Help > Additional Help 
Online > FAQ for more information."

"Some On Demand services are unavailable. Logging in at a later 
time may resolve the problem."

Solutions
Jukebox

1 Open the task manager [Ctrl-Alt-Del] and select the 
Processes tab.

2 Highlight mmjb.exe [if it exists] and press the End Processes 
button [press OK to the pop up dialog].

3 Highlight mim.exe and press the End Processes button [press 
OK to the pop up dialog].

User Settings
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1 Set up your XP login with administrator rights from Start 
menu > Control Panel > User Accounts. 

Internet Explorer

Right-click on Internet Explorer from your desktop and select 
Properties.

1 Select the Privacy tab and make sure your cookie tolerance is 
set to Medium or lower.

2 Select the Security tab and click the Default Level button 
from the lower right side.

• If this button is not active, set the level to Medium or 
lower.

3 From the Security tab, highlight Trusted Sites and press the 
Sites button

• Uncheck the option Require server verification (https:) 
for all sites in this zone.

• In the Add this Web site to the zone text box, type in 
http://www.musicmatch.com and press the Add button.

4 Select the Advanced tab and place a checkmark next to the 
following options:
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• Enable Install on Demand (Internet Explorer)

• Enable Install on Demand (Other)

5 Select the Connections tab, and make sure the following 
options are correct:

a If you're using a Modem, click on the name of your ISP 
and press the Settings button.

• Uncheck the box that reads Use a proxy server for 
this connection

b If you’re using a Cable service [Comcast, Cox, 
RoadRunner, etc], press the LAN Settings button.

• Uncheck the box that reads Use a proxy server for 
your LAN

Windows Media Player 10

If you don't have Windows Media Player (WMP)10, install it from 
http://www.microsoft.com/downloads/details.aspx?FamilyID=
b446ae53-3759-40cf-80d5-cde4bbe07999&displaylang=en

1 Press the down arrow in the top right corner of WMP and 
select Tools / Options. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=b446ae53-3759-40cf-80d5-cde4bbe07999&displaylang=en
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2 Select the Privacy tab and place a checkmark next to the 
following options: 

• Acquire licenses automatically for protected content.

• Send unique Player ID to content providers.

Firewall/Antivirus Software

Do you have an active Firewall? Go to the Start menu, select 
Control Panel, then select Security Options. 

1 Select the Windows Firewall link under Manage Security 
Settings. If the firewall is on, continue.

• Select the General tab and uncheck Don't allow 
exceptions

2 Select the Exceptions tab, press the Add Program button, and 
press the Browse button.

• Select the My Computer shortcut from the browse dialog 
and navigate to C:\Program 
Files\Musicmatch\Musicmatch Jukebox\

• Add the following programs: mmjb.exe, 
mm_TDMEngine.exe, mim.exe, mimboot.exe, 
MMJBBurn.exe, mmjblaunch.exe, and mm_server.exe.
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If you are running a firewall other than Windows Firewall, unblock 
the following programs: mmjb.exe, mm_TDMEngine.exe, 
mim.exe, mimboot.exe, MMJBBurn.exe, mmjblaunch.exe, and 
mm_server.exe.

General Usage

1 Add tracks to your portable device

a Connect the portable device to your computer as 
instructed in the Getting Started Guide.

b Click the Portable Device button to open the Portable 
Device Manager, (or send tracks to the PDM by selecting 
the menu File>Send to Portable Device).

 NOTE: When you first connect your portable device, the Portable 
Device Assistant should open, giving you options on how to add 
music to the device; either manually or automatically through 
synchronization. You may opt to cancel the assistant and simply add 
tracks via drag-and-drop, clicking the Add button, or clicking the 
Send To button under the Playlist Window.)

2 Device Assistant

When the Device Assistant opens it helps you copy music to 
the device. 
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a Decide if you want to manually add tracks, or have the 
process more automated by using synchronization.

Manually Add Tracks - You may either:

• drag-and-drop tracks into the PDM window, 

• click the Add button in the PDM window, or 

• click the Send To button on the Playlist window to 
send your Playlist to the PDM window.

Automatically add tracks using synchronization 

b Click Next. You have two options:

• Choose a random assortment of tracks (from your 
playlists or library)

• Transfer as much as possible of each source (from 
your playlists or library)

 NOTE: Either choice attempts to use all tracks, but only uses as 
many tracks as can fit on the portable device.

c Click Next. Select the Playlists you'd like to transfer, or 
choose All Musicmatch Library Tracks. Musicmatch 
calculates and display the amount of space required based 
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on your selection, and display the amount of space 
available on your device.

d Musicmatch is now ready to copy files to the device. You 
now have two options next time you connect your device.

• To have the assistant display again. This lets you use 
this automated assistant to add files to your portable 
device.

• To not have the assistant display and have 
synchronization occur automatically each time you 
connect your device, using the same settings you 
have just selected in the previous steps.

e Click SyncNow. Tracks begin to transfer.  

 NOTE: If your device does not display, you may need to download a 
plug-in for it. Click the Tools button and select Add A Device Plug-in. 
Find your device and click on its picture. The plugin downloads and 
installs automatically. Reattach your portable device and try again.

 NOTE: MusicMatch Jukebox Software, which is included on your 
Dell DJ Ditty Product Software CD, already has the Dell DJ Ditty Plug-
in Preinstalled.
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4
Appendix

Specifications

Hardware

Display LCD
96 x 32 resolution
Blue EL back light

Storage media 512MB non-volatile flash memory

Battery Embedded lithium-polymer 
300mAh max.

Computer connection USB 2.0/1.1
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Performance Parameters

Audio quality (specifications based on 32-ohm 
load at 1-kHz tone are typical 
values)

Signal-to-noise ratio up to 92 dB

Channel separation up to 65 dB

Frequency response 24 Hz-20 kHz (headphones)

Harmonic distortion < 0.1%

Playtime up to 14 hours (based on 128 kbps 
MP3 songs, continuous playback, 
volume 7(maximum 21), EQ off, 
using included Dell earphones)

Battery charging time 2.5 hrs

Operating temperature 0°C/32°F to 40°C/104°F

Storage temperature -10°C/14°F to 45°C/113°F



84 Appendix

Supported Audio Formats

MP3 Bitrates 8 ~ 320 kbps, Variable 
Bitrate (VBR) supported

WMA Bitrates 32~192 kbps, Variable 
Bitrate (VBR) supported

PlaysForSure Licensed WMA

Audible files Format 2, format 3 and format 4.

Supported Operating Systems

Windows XP Home 32 bit, SP 1, Windows Media 
Player 10

Windows XP Professional 32 bit, SP 1, Windows Media 
Player 10
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Glossary
AUDIBLE—Audible format is used for Audiobooks which can be 
downloaded and listened to on your Dell DJ Ditty. When you stop 
listening to an Audiobook and return to it later, it will still be at the same 
place.

BITRATE —A bitrate indicates the average number of bits in 1 second of a 
digital audio track. MP3 encoders allow you to specify the bitrate when 
making MP3 files. The higher the bitrate, the better the audio quality. 
Unfortunately, this also means a larger file size.

DIGITAL RIGHTS MANAGEMENT (DRM) —A technology enabling the 
copyright owner of intellectual property, like a digital audio track, to 
control file usage. It is normally used to allow you to download digital 
audio tracks while preventing you from distributing the files to other 
people or other devices. With DRM, digital audio tracks contain digital 
signatures. Your Dell DJ Ditty is DRM-compliant.

EQ—Short for "Graphic Equalizer". Different settings will boost or 
reduce certain frequencies and enchance the sound.

FIRMWARE —The software in your device that allows you to perform 
numerous functions including playing audio.

KBPS —Kilobits-per-second. A measure of how good the bitrate is. 128 kbps 
is the standard bitrate for MP3 files. 128-kbps MP3s are near-CD quality. 
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Some other commonly used encoding rates are 160 or 192kbps.

LITHIUM-POLYMER BATTERY (LI-POLY) —A battery composed of 
lithium, a light metal with high electrochemical potential. Lithium 
batteries are light and store high amounts of electrical energy. Because of 
this, lithium-polymer batteries are ideal for your portable device. Lithium-
polymer batteries do not use poisonous metals, such as lead, mercury, or 
cadmium, and have no "memory effect" problems (caused by not being 
fully discharged before a new recharge, and remembering a shorter 
battery cycle). However, they are more expensive than conventional 
nickel-cadmium (NiCad) and nickel metalhydride (NiMH) batteries. 
Your Dell DJ Ditty uses a Li-Poly battery.

MEGABYTE (MB) —About 1 million bytes. Bytes, megabytes, and 
gigabytes are measures of how much data a storage device can hold. 
For example, a 3-minute MP3 encoded at standard bitrates is 
approximately 3 MB in size.

MP3 —A member of the MPEG compression family, MP3 is a 
commonly used compressed digital-audio format. MP3 encoding 
transforms digital audio files (like WAV) to provide reasonable audio 
quality in relatively small file sizes.

PLAYSFORSURE—Digital Rights Managed music in WMA format (See 
reference to Digital Rights Management above).

SHUFFLE —A Play mode that randomly plays tracks once only from the 



Appendix 87

Selected Music list.

SHUFFLE REPEAT —A Play Mode that randomly plays tracks from the 
Selected Music List repeatedly.

USB —Universal Serial Bus. A moderately high-speed input/output 
technology for "hot swap" data transfers, meaning that you can connect 
or disconnect a USB device without turning off your computer. Your 
Dell DJ Ditty uses the newer USB 2.0 standard that allows for higher 
speed transfers than USB 1.1.

WMA —Windows Media Audio. This is the standard used by Windows 
Media. Your Dell DJ Ditty can play tracks in this format, as well as MP3.
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Index

A
AB mode, 21-22

Available space, 35

B
Backlight duration, 32

C
Contrast level, 32

D
Data Files, 40

Date & Time, 22

Date and Time, 29

Digital Rights Management, 19

Display, 29

download, 56

E
EQ, 32

Error Indications, 47
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Error Messages, 74

F
Fast Forward/Skip Forward, 11, 

20

Firmware, 53

firmware, 73

Firmware version, 35

FM Radio, 22

H
Headphone Connector, 11

Home/Power Button, 11

I
Idle Timer, 32

Information, 35

L
Language, 32

Lanyard Attachment, 12

LCD Screen, 11

license agreement, 60

Listen to a preset station, 28

Lock keys, 21

M
Main Menu, 22
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Music Library, 22, 25

Music Store, 52

Musicmatch Downloads, 68

Musicmatch Help, 36

Musicmatch Library, 37

Musicmatch Music Store, 64

Musicmatch Radio, 61

Musicmatch®, 36

N
Normal, 25

Number of tracks, 35

O
On Demand, 52

On Demand Portable, 55

P
Play All, 23-24

Play Mode, 22

Play/Pause, 11, 20

PlaysForSure, 19

Portable Device Manager, 37, 
39

Preset, 27
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R
Radio, 52

Repeat All, 26

Repeat Track, 25

Reset Button, 11

Rewind/Skip Back, 11, 20

S
SEEK, 28

Settings & Info, 23

Shuffle, 26

Shuffle Repeat, 26

Sleep timer, 30

Solutions, 74

Spoken Word Audio, 24

Synchronization, 40

T
Troubleshooting, 48

U
Unlock keys, 21

USB Connector, 11

USB Protective Cap, 11

V
Volume/Scroll/Select Dial, 11
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W
Windows Media Player 10, 76

WMA, 19
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